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Freehand Graphics, Adobe, and Corel provide critical software solutions screenprinters trust to efficiently run their art and pre-press departments.
AccuRIP Software by Freehand Graphics is the leading industry RIP for producing
FILMs from an Epson Inkjet (solids and halftones).

Welcome to the superior AccuRIP Software Black Pearl™ user experience.
Ease-of-use and high-quality film production is what you’ll experience working with AccuRIP Software. It’s a fast-paced
world of changing technology - let AccuRIP Software and Freehand Graphics be the stability you count on.
Freehand has delivered to screen-printers AccuRIP’s most robust engine yet. Aptly named “Black Pearl” for the darker, easier
on the eyes User Interface. This version is loaded with enhancements plus we made easy output - even easier!

HOT TIP:
Online is where you will find all the information you need to succeed. Have a question? Need advice or support?
Use the resource that is updated and accessible ONLINE 24/7...

www.softwareforscreenprinters.com

Use other Freehand Graphics software and solutions to enhance your pre-press experience and improve your print results.
For information on All Black Ink™, The Ditto Inkjet Film Feeder™, Spot Process Separation Studio, and other
products available visit our website or speak with our valued resellers.

AccuRIP Software: expertly engineered by screen-printers for screen-printers.
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www.softwareforscreenprinters.com
Go online for up-to-date information, installers, user account log-in access, articles,
videos, support options, and much more!
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AccuRIP Compatibility Information
AccuRIP Software™ is a Microsoft® Windows™ and Apple® Operating System RIP software expertly engineered to exceed the
special requirements of the screen-printer using an inkjet printer to produce top-quality, high-density black film positives
from graphics files to an Epson inkjet. Dozens of Epson models are supported; go online to view a current list.
https://softwareforscreenprinters.com/support/compatibility/

MUST READ:
A stable Internet connection on the computer where AccuRIP Black Pearl is installed is required.
Users without internet can not install, register, transfer their License or receive FREE Updates.
A Genuine Epson Print Driver must be installed, the printer connected, and fully operational.

Supported Operating Systems:

Microsoft OS

Apple OS

Vista and higher (later)

Mountain Lion (Intel) and higher

IMPORTANT OS INFO:

Windows and/or Macintosh Operating System announcements are posted on our website.
Our expert engineers develop updates for new OS releases from Microsoft and Apple - noting that support of a new OS
requires time and diligence to ensure a great user experience. To prevent unnecessary downtime do NOT update to a
new OS until you get verification from all software manufacturers including Freehand.

Supported Epson Printers:
AccuRIP Software supports dozens of Epson Inkjet Printers.
For an up-to-date list of models visit the website: www.softwareforscreenprinters.com
Select COMPATIBILITY CHART located under the SUPPORT link option.

5

ACCURIP USER GUIDE

AccuRIP Software Installers
Go to:

www.softwareforscreenprinters.com

FREE 14-Day Full Use Version (trial period expires on day 15):

t

Go to MY ACCOUNT > Login/Register. Login or create an Account. Then select DOWNLOADS.

Full License Version:
Follow the email instructions from
your Reseller or Freehand provided
after purchase. An Account Login is
required for all users. A link to the
Full Version Installer will be provided.

FREE 14-Day Use...
NO WATERMARK on your FILMS!
Go to press. Make money.
Why call it a 14-day use version and not a trial? Because it is fully-functional software allowing you to produce films and
make money during the 14-day period. It will stop working after the 14-days. Many software “trials” are limited in features
or add watermarks. If you are reviewing this User-Guide you may be starting your first experience with AccuRIP Black Pearl.
Expect success. Contact Support with any needs. Review the FREE and valuable online support materials.

Full License...
Congratulations on your decision to join the tens of thousands of successful companies around the world that use AccuRIP
Software to produce great films from their inkjet printer. Welcome. We encourage you to take a look at out entire product
line and contact Freehand or your reseller with any questions.
Purchase a Serial Number License through...
• an Authorized Reseller, or
• Freehand’s Web Store
• never from an end user.
Delivery of the Serial Number will be through a redemption code traded in for a serial number (Reseller delivery), or automatically (Freehand web store) delivered to your My Account page upon approval of web store ecommerce purchase.
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Features...
1. Continued Support
AccuRIP Black Pearl users enjoy Live Agent Support. Operating current versions provide important user benefits
over previous (end of life) versions. Expect to be productive everyday, when you do need us we’re happy to help.

2. Automatic Printer Detection and Connection
Engineered into AccuRIP Black Pearl - the intelligence to DETECT and CONNECT. The WIZARD automatically
finds installed Print Drivers - an amazing enhancement! In addition, the “View All Printers” feature offers an
optional and easy manual configuration setup. Setup is super simple for all level users.

3. Print Setting IQ
PS-IQ remembers your last configured settings for all previously configured printers.

4. WiFi Strong
AccuRIP Black Pearl takes full advantage of the benefits and convenience of WiFi. You’ll appreciate how easy
it is to connect to and print with WiFi. Knowing and understanding IP addressing is a thing of the past for AccuRIP.

5. WatchDog Doctor
Automatically detects then adds printer driver(s) to Operating System upon software launch (opening).If your
printer driver was removed or deleted inadvertently AccuRIP Black Pearl will build a new driver automatically
based upon the last printer configuration. This is an AMAZING enhancement.

6. Print to any supported USB printer on your network
AccuRIP now automatically detects shared USB printers - even those shared from other computers (LAN). Printers no longer need to be directly connected to an AccuRIP hosting computer, providing a greater level of Admin
control. Setup a shared Epson Printer Driver for ANY USB printer on your network and AccuRIP will auto detect
and allow configuration.

7. The Wizard
Double-click AccuRIP Black Pearl’s Installer and the Wizard appears to efficiently guide you through initial
setup- it takes just a few minutes from start to finish. Plus, any doubts you have about printer connections are
gone. Black Pearl auto detects and connects printers. Now you can access the Wizard at any time, not just at
initial setup.

8. Configure Printer and Configure Halftone
Streamlined to a two Tabs Configuration Window, connect to the Epson inkjet and select your settings such as
halftone shape, frequency (line screen), screen angle and more.
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9. Quick Menu organizes your workspace and saves valuable time
This User Interface NEW addition consolidated important menu options into one easy to locate, single-click,
pop-down menu on the Tool Bar, saving you valuable time.

10. Settings at a glance
Status Bar, located at the bottom of the User Interface, displays important settings. These are your selected
and locked in settings. Never output film with the wrong line screen or shape, because you forgot what settings
were in place, or another user sharing AccuRIP made a settings change.

11. Stay up-to-date FREE
AccuRIP Black Pearl auto checks for version updates. When Savailable simply CLICK to update at no cost.

12. Streamlined Tool Bar for enhanced workflow
Consolidated tools, single toggle icon controllers, and easy access to functions such as PAUSE and DELETE.

13. Easy on the eyes brand new User-Interface. A gem of a software release
Easier on the eyes U.I. reduces eye strain and fatigu. This version is named Black Pearl for the darker backgrounds of the on-screen windows and the great valuable it provides. The great new design looks beautiful,
and consolidated features.

14. Under-the-hood enhancements
A speed boost and coded for newer processor architectures, this advanced level PostScript engine also ensures
that users achieve the professional film output required to expose screens for screen-printing. On-demand,
driver-based functionality made AccuRIP the number one industry choice for nearly a decade.

Summary ____________________________________________________________________
AccuRIP’s accuracy, functionality, speed, power, and friendly user interface are unequalled. Work efficiently. Never be slowed
by an awkward and repetitive workflow, or faced with confusing options seen with other solutions.
Below: AccuRIP’s QUICK MENU.

From feature names that screen-printers easily understand, to clean and
consolidated windows, and easy access to the tools and features you use, the AccuRIP
User Experience is outstanding. Print films without launching AccuRIP. Launch
AccuRIP to view the Job Queue, displayed settings, and to use the NEW QUICK MENU.
Remember, AccuRIP is driver-based. This allows you to select the AccuRIP to Epson
Driver in the Print Window of any graphics program file you are working in (i.e.
Adobe, Corel). Your settings are automatically applied.
There is no simpler workflow than the AccuRIP workflow, and the end result...
professional films.
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Droplet Weight Density Test Print

t

Valuable Feature... designed for screen-printers!

The Droplet Weight Density Test Print (DWDTP) is a unique feature of AccuRIP
Software designed specifically for screen-printers. Much more than just an
option in AccuRIP and a test of ink on film, it is the key to the success of
pre-press and ultimately the quality of your press prints. With quality and
productivity high, and costs under control, your profitability rises.
What comes between your art file creation and the screen-print press is FILM
and SCREEN EXPOSURE.
The key to properly exposing emulsion is the control of UV light. UV light is NOT visible to the human eye. Holding up your
film and looking at it offers you little information about screen exposure expected results, and whether you are using your
consumables efficiently . Most screen-printers do NOT have an expensive device called a Transmission Densitometer to
provide UV light readings. AccuRIP’s Droplet Weight Density Test Print replaces the need for an expensive device and allows
you to confidently produce films for screen exposure.
A Droplet Weight Density Test Print on Film will deliver 15 droplet weights per resolution. Produce a Droplet Weight Test film
for each available resolution in the AccuRIP Setup starting at the lowest resolution. Your goal is to achieve great results using
the lowest resolution to save ink, time, and money each and every day. Each Droplet Weight Test produced should be used to
expose a screen, then washed out. Screen exposure is the desired way to select a droplet weight to suit your shops needs.
Expose the emulsioned screen in your screen exposure unit. Determine which droplet weight of the 15 washes out easily and
gently, providing the detail you need for the press. Use the tested and proven droplet weight and resolution setting in
AccuRIP for your pre-press screen making process. You are also using this opportunity to review the quality and state of your
exposure unit, screen coating products ,screen coating ability, and exposure time.

Emulsion, Mesh, Exposure Units and More
Understanding how to properly emulsion a screen, selecting the best emulsion, and using and understanding your exposure
unit will make you a better screen-printer. If you are not getting the best results, quality is dropping off, your determined
screen exposure time is no longer doing the job, the durability of the screens is not satisfactory, or other screen exposure
issue exists, consult the manufacturers of these products for info and assistance, or contact your resellers and suppliers for
alternative products. Screen exposure is absolutely critical to you success on press.
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Serial Numbers, License Transfer, and Security
Serial Numbers provide access to the FULL VERSION of AccuRIP Black Pearl Software. They are UNIVERSAL - used for both
Windows or Apple supported operating systems. User that have upgraded from a previous AccuRIP version will no
longer use the previously supplied Serial Number.
• Serial Numbers are unique to each each License holder.
• Treat Serial Numbers like personal passwords. Keep them secure. (Stored in My Account, but keep separate records)
• A Serial Number must be entered exactly as it appears. Example: ACCURIPBP-N0TA-REAL-SERI-ALNU-MBER
Enter your unique Serial Number in the Window that appears during first-time installation using the Wizard. The License
allows the Serial Number to be used to install AccuRIP Black Pearl on one computer. After installation and when you are
successfully printing using the AccuRIP to Epson Driver for your supported Epson Inkjet, sharing the AccuRIP Driver to other
users across your Local Area Network (LAN) is an option that extends its use to other users at no additional cost. For more
information visit www.softwareforscreenprinters.com .
The License can easily be transferred to another computer within the same Licensed company. The ability to TRANSFER is
under the ACTIVATION MENU of AccuRIP when launched (open).

HOT TIP:
If you receive an error that the Serial Number is already in use, then it has already been used to activate a computer in your
environment. You can move a Serial Number from one computer to another within your envirnoment through the
ACTIVATION MENU > Transfer Activation.

To view your AccuRIP Black Pearl Serial Number
go to the ABOUT AccuRIP Menu (Apple),
and SUPPORT MENU > ABOUT
(Windows).
AR-BP-N0TA-REAL-SERI-ALNU-MBER
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Epson Drivers / Installation / Configure Wizard
Step 1 (Epson Driver):
• DOWNLOAD the genuine Epson Driver from www.Epson.com for your specific printer model. The genuine Epson Printer
Driver for your model and OS must be installed before proceeding with the AccuRIP Setup.

MUST READ:
Do NOT use an Epson CD or other media to obtain an Epson Driver. Proceed to step 2 ONLY after you are printing with the
genuine Epson Driver. Contact Epson with Epson driver or hardware issues/questions.

Step 2 (AccuRIP Installer):
• Download the AccuRIP Installer to your local computer (i.e. desktop). Do NOT RUN Installer from within the web browser.
Double-click to RUN the AccuRIP Installer Package (Pkg). Follow the on-screen instructions during the installation process.
14-Day Use Version (trial) Installer is available from the downloads page of www.softwareforscreenprinters.com. Full Use
License users receives an email with specific download instructions. Note: an Account Login on the site is required.

• After successful installation, go to the Programs Folder (Windows), or Application Folder (Mac). Double-click the
AccuRIP Icon (registration target logo). The CONFIGURE WIZARD (formerly called the Setup WIZARD) will launch.

Step 3 (AccuRIP Configure Wizard):
• Follow the CONFIGURE WIZARD as it steps you through the fast and easy setup. Done. You are ready to output files using
the AccuRIP to Epson Driver.

Access Configuration at any time.
The two TAB Configuration Window displays your selections in the Configure Printer and Configure Halftone Tabs.
Access CONFIGURATION Window at anytime to change settings, such as connecting to a new Epson model, changing a line
screen, or screen angle (see page 11).
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AccuRIP’s Advanced Setup helps users make proper connections.
Configuration Window (multi-black feature OFF).
AccuRIP Black Pearl’s convenient two Tab Configuration Window is your setting control center. Access it anytime a setting
change is needed. The Ink Setup selection shown has Multi-black checked off.

LEFT: AccuRIP
Black Pearl’s
Configure Window
(formerly called
Setup).
In this example, the
Configure Printer
Tab is shown and
the Multi-black
feature for All Black
Ink users has NOT
been checked.
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Configuration Window (multi-black feature ON for users of All Black Ink).
AccuRIP Black Pearl’s convenient two Tab Configuration Window is your setting control center. Access it anytime a setting
change is needed. The Ink Setup selection shown below has Multi-black checked on. When checked it displays the color ink
tanks (by name) for that particular model. Example shown is a 6 slot Epson Artisan 1430 inkjet printer.

LEFT: AccuRIP’s
Configure Window
displaying the
Configure Printer
Tab is shown with
Multi-black feature
for All Black Ink users checked ON.
It auto displays the
slots for the
Epson model
selected in the
Detected &
Supported Printers.
Labeled by color
(not slot number).
The default INK
COVERAGE option
is Standard Ink and
the recommended
coverage for most
users of All Black
Ink by Freehand.
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Configuration Options Explained.
TAB 1: Configure Printer

Detected & Supported Printers:
Automatically displays printers installed on or shared to your computer. From the pop-down option list select the proper
model printer (i.e. Epson Artisan 1430 (IP). Note: you may have more than one option for a specific Epson model. AccuRIP
detects and displays ALL Epson Printer Drivers even duplicates, or multiple connection types.

View All Printers:
Displays ALL printers installed on or shared to your computer (even non Epson inkjet printers). So why do I need this feature
when AccuRIP Auto Detects? It is unlikely that a presently supported Epson printer will not automatically be detected. In the
rare case that you do have a supported Epson printer properly installed and not detected (possibly due to name changes),
use this feature to manually setup and create an AccuRIP Print Driver. Follow the instruction in the Setup Window.
When you do NOT see your supported printer in the list, contact Live Agent Support. Do NOT use the manual setup option
without assistance from support.
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LEFT: AccuRIP
Black Pearl’s
Media setup.

Media Type and Size:
MEDIA TYPE:
Choose the Media Type (Roll or Sheet) used with your printer model. In the example above, SHEET size was selected. If you
will be using a roll, select ROLL.

SIZE (Sheet or Roll Users):
Sheet users select the largest film sheet size to be used. Users routinely use more than one
size film sheet, but you do NOT have to change the Sheet size setting each time you load
a different size. AccuRIP uses the page size dimensions set in a graphics application print
window. Simply match artboard (page size) to the loaded film size to print. AccuRIP’s sheet
size only has to match the page size when you wish to take advantage of N-UP Printing
(nesting). For N-UP printing go to www.softwareforscreenprinters.com to view videos and
articles.

ABOVE: Example of sheet size
options available for the desktop
printer selected in the Detected &
Supported Printers or after manual

ROLL users match the roll width of your installed film media to the option provided in the
pop-down menu in AccuRIP Black Pearl. You can change these options anytime you make
a change in the ROLL size installed on the inkjet printer.

Setup using the View All Printers
option.

ABOVE: Example of roll size options
The size selected in the pop-down
must match the roll size installed
on your inkjet printer.
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LEFT: AccuRIP
Black Pearl’s
Ink Setup option
with Multi-black
on. Example is an
Epson Artisan 1430
inkjet displaying
all 6 color slots
checked on.

Ink Setup (Multi-black):
CHECK this option to turn on the Multi-black feature ability in AccuRIP Black Pearl. Multi-black must be ON when using
Freehand’s All Black Ink™ cartridge-based ink system which delivers cartridges with top-quality BLACK DYE for each
slot of the printer. When UNCHECKED (off) AccuRIP will use ink from the printer’s PHOTO BLACK tank/slot ONLY.
By default the Multi-black feature is OFF.
When CHECKED (on) the window displays ALL ink slot color names for the printer model you selected during setup
indicating that ink will be used from all of those checked slots. Note: you can also turn specific slots ON or OFF.
For more information about Freehand’s All Black Ink system for use with AccuRIP and the Epson models that are
supported, visit the website: www.softwareforscreenprinters.com

Ink Coverage:
This pop-down menu option is displayed only when the Multi-black feature is CHECKED on. Note: the Multi-black
feature is checked on ONLY for users of the All Black Ink cartridge system. If you do NOT have All Black loaded in your
printer DO NOT turn this feature on or you will be printing color ink to your films. The default setting is STANDARD.
The options are LESS, STANDARD, and MORE INK. Standard is the recommended setting. It is a fine tuning feature for
the droplet weight feature of AccuRIP when a little more or less is needed within a print resolution. For information
about the valuable DROPLET WEIGHT DENSITY TEST PRINT to evaluate/select ink droplet weight (see page 8 ).

LEFT: AccuRIP Black Pearl’s Ink Coverage pop-down menu displaying the three available settings. This fine tuning option
is available to users of Freehand’s ALL Black Ink system that have checked the Multi-black feature on after they have
installed All Black Ink into their supported Epson inkjet.
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LEFT: AccuRIP
Black Pearl’s
Printer setup.

Printer Setup:
PRINT RESOLUTION:
The pop-down menu displays printer resolution options for the selected Epson printer
model in the Configuration Window. Available options vary per model. Higher resolutions
print slower and use more ink. Lower resolutions often provide desirable results for screenprinters. Start at the lowest resolution (saves time and ink) and increase the resolution
if you are not satisifed with the film output results. Use AccuRIP’s DROPLET WEIGHT
DENSITY TEST PRINT to determine the best resolution and droplet weight (see below).
DROPLET WEIGHT (Ink):
Default setting varies from model to model. AccuRIP’s defaults droplet weight is a good
starting point. The DROPLET WEIGHT DENSITY TEST PRINT (DWDTP) is under the FILE
MENU, and the QUICK MENU located in the Tool Bar (when AccuRIP is launched). A full
explanation of the Droplet Weight Density Test Print is provided (see page 8).
HIGH SPEED:
Default setting is OFF. High Speed instructs the printer to spray ink down as the print head
moves in BOTH directions to speed up the printing. Judge results for quality. Printers are
most accurate with high speed feature off. Older printers or printers out of alignment may
deliver reduced accuracy.

ABOVE: Example
of the available
print resolution
in the pop-down
menu (for the
Epson 1430).
LEFT: The droplet
weight option
pop-down menu
available for ALL
AccuRIP supported
Epson inkjets.

ADJUST PRINT LENGTH (Roll Feed Users Only):
Compensates for the stretching of film through a roll feed printer. Some brands of film media require special adjustments to
internal printer rollers in order to achive perfect registration. When media slips inside the printer, registration can be off up to
1/16 of an inch longer (height) than expected. There will never be issues with image width, only height. In these cases
adjustments to the Adjust Print Length feature fixes the issue. Follow the directions to print a PAPER MASTER. Then repeat the
same print on your brand of film media. Make adjustments and re-print until your film matches perfectly with your PAPER
MASTER. If trouble continues, try a different brand of film. Locate the Adjust Print Length document here:
https://softwareforscreenprinters.com/support/guides/
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Configuration Window with Configure Halftone Tab displayed.

LEFT: AccuRIP’s
Configure Window
(formerly called
Setup).
In this example, the
Configure Halftone
Tab is shown. This
tab provides option
for Screen (shape),
the Lock Screens
feature, Angle,
Frequency and Dot
Gain Control.

18

ACCURIP USER GUIDE

TAB 2: Configure Halftone

Screen:
The pop-down menu provides the option to select the SHAPE of the spot (halftone).
The available options are ROUND, DIAMOND, LINE, ELLIPSE, and FM.
The most popular Screen shapes selected by screen-printers are ellipse and round.
For information about FM (see page XX).

Lock Screens / Angle / Frequency:
AccuIP provides two controls for setting the parameters for halftone printing.
1. LOCK SCREENS ON
The default and recommended selection, when ON the control of Halftone settings are with AccuRIP Black Pearl. The settings
selected in this TAB will be applied during output each time the AccuRIP to Epson Driver for your model printer is used to
print a file. When there is a need for halftones in the file, they will be printed with the selected settings in AccuRIP (overriding
graphics program settings). This is a great feature for screen-printers that have standard halftone settings and mesh counts
for their shop. LOCK SCREENS save time and money by preventing errors that happen when the control is with the graphics
program and the user forgets to enter the settings (or properly) with each film.
2. LOCK SCREENS OFF
When Lock Screens is off (unchecked) the control of the settings is given to the graphics software you are printing from using
the AccuRIP to Epson Driver. Adobe Illustrator and CorelDRAW, for example, provide these options in their Print Windows.
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With Lock Screens off, address each option for every color on every film being output. This is annoying and time consuming
and opens up the opportunity for costly user errors. Lock Screen is strongly advised.
A situation when a user would use AccuRIP with Lock Screens off is when producing multi-angle film output. Although single
angle printing remains the standard for the screen-print industry since it delivers the cleanest results even for 4 color (cmyk)
process, some users still choose to create multi-angle process color separations. Remember to turn Lock Screens back ON
after completing the process.
ANGLE:
The default angle setting is 22.5 degrees. It is mathematically best for screen-printing. Select or change the setting in this
feature.
FREQUENCY:
Frequency is the physical SIZE of the halftone. The screen-print industry uses coarser halftones than other print industries.
The default setting is 45. You may also be familiar with the term line screen or dot screen or spot screen, but they all refer to
halftone SIZE.

HOT TIP:
Selecting the FREQUENCY (Line Screen) must correlate to the SCREEN MESH COUNT you will use when making your press
screens. Simple math formulas assist you with your selection. An incorrect selection will deliver poor print results.
The MESH COUNT should be 4 to 5 times the Line Screen.
Example: 45 line screen (frequency) X 5 = 225. Select the closest mesh count (equal or higher, never lower) such as a 230
mesh (US measurements).
-or The LINE SCREEN should be 1/4 or 1/5th the Mesh Count.
Example: 230 mesh divided by 5 = 46. Select 46 as the Frequency. You can round up or down such as 45.
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LEFT: A Screen
shape option is FM.

FM SCREENING:
FM Frequency Modulated screening is very different than AM Amplitude Modulated screening (halftone). Requires testing
and an advanced understanding of image print production. All shapes are the same size across the screen achieveing tonal
changes by packing more or less data into a given area. Less data delivers lighter tones while heavily packed areas deliver
darker more saturated tones. AM screening varies the geometeric shapes based on area tone. AM is a more common
selection and more friendly to various printer resolutions. Choosing FM is suggested when printing only an image, not text.
FM screening requires the use of squared printer resolutions. For example, 720x720 or 1440x1440 resolutions will produce
expected results while non squared resolutions, such as 720x1440 will produce unexpected results. Not all Epson printer
models offer a variety of squared resolutions.
Dot Size: Measured in Microns, larger numbers producelarger coarse results, while lower numbers produce finer detail.
Testing is required to determine compatible printing mesh sizes to micron selections.
Gamma: Controls the mid gray values across the blend field. Similar to the mid skew of a gradient blend tool in a graphics
program. User testing is required.
How to test: Create a gardient blend in your favorite graphics program, make changes to setting and print. Evaluate results
and set RIP to desired configuration.
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LEFT: Dot Gain
Control is an
Advanced Feature
used ONLY with a
Transmission
Densitometer.
Incorrect use of this
advanced level
feature will yield
odd output results.

Dot Gain Control:
AccuRIP’s Dot Gain Control is an advanced level feature used ONLY with a Transmission Densitometer and an understanding
of how to use it properly.

Understanding Dot Gain for Screen-Printing
Don’t fear it, control it. The goal - good looking prints. Only some users with high line screen requirements will need to
address dot gain through software. When ink meets the garment on-press, and during film output when the ink meets the
film media is where you can experience dot gain. There is NO dot gain happening using the RIP. But, your RIP provides
opportunity to professionally compensate for it on-press and on film.
Are you missing out on an important feature of AccuRIP, because you do not have a Transmission Densitometer? Absolutely
not. AccuRIP Black Pearl is a RIP expertly engineered for screen-printers using Epson inkets for professional film output.
AccuRIP’s configuration is accurate, and will meet the strict requirements of most screen-printers.
Dot gain on press? There is no procedure or equipment to measure dot gain on a garment. Look at a print to determine if it is
an unacceptable (visual) result. Control it by changing the films to help compensate for the ink spreading on a garment.
The film is a tool to help achieve desirable press results.
Go to the BLOG at www.softwareforscreenprinters.com for the info you need to know.
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AccuRIP Black Pearl Menus and Tools Explained
AccuRIP Black Pearl includes new MENU and feature enhancements. Previous version users should become familiar with the
menus and tools designed to enhance the AccuRIP workflow.
Located top left of computer screen (next to the Apple icon, Apple OS), and on top of the AccuRIP User Interface (Windows
OS). AccuRIP Software needs to be launched (open) to see the Menu.

ABOVE: Apple Operating System Menu Bar.

ABOVE: Windows Operating System Menu Bar.

AccuRIP Menu (Apple ONLY)________________________________________________________________________
AccuRIP Menu
Displays the software name, version, build number, copyright, activated SERIAL NUMBER, and a website link.

Quit AccuRIP
Closes the main User Interface Window.

File Menu (Apple/Windows)___________________________________________________________________
Edit Configuration
Displays and allows for editing all RIP settings.

Run Configuration Wizard
A step by step user friendly way to set up print drivers.

Test Print
Located under the File Menu and Quick Menu. Used to test printer connections and determine print quality of halftones, text
and solid area density.
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Droplet Weight (Density) Test Print (DWDTP)
Located under the File Menu and Quick Menu, this valuable and unique feature of AccuRIP delivers an automatic test print to
film of 15 droplet weights. Perform a DWDTP for a specific selected print resolution. The best way to determine your optimal
settings is to expose the printed film to a screen. Exposing the test film to a screen will help determine the best ink droplet
weight setting based on your pre-press supplies and workflows. Configure AccuRIP to use the best setting.

Quit AccuRIP (Windows ONLY)
Closes the main user interface window.

Jobs Menu (Apple/Windows)__________________________________________________________________
Refresh Job List
Refreshes (re-displays) the Job List providing the current list. Similar to refreshing a web browser.

Pause Job Processing
Displayed as a double bar icon in the tool bar, pauses current processing job into pause (on hold).

Resume Job Processing
Displayed as a printer icon in the tool bar, select it to unpause a job that is paused (on hold).

Delete Job
Displayed as a trash can icon in the tool bar, deletes/removes selected jobs in the Job Queue.

Cancel All Jobs
Deletes/removes ALL jobs in the Job Queue.

View Menu (Apple/Windows)__________________________________________________________________
Job History Window
Displays previously processed or failed Job Names and AccuRIP’s Job ID. Successfully printed files will display a green check
mark to the left of the job name. Failed files will display a red X. Failed files usually contain a postscript error (convert text to
outline/curves and move the image to NEW page before reprinting).
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Job Details Window
Displays postscript information and print spool times. Hidden by default, technical information not necessary for end-user
function.

Tool Bar (Floating) Located under the View Menu, select it to display the Tool Bar which contains the Trash Can, and
Pause/Play icons. The tool bar is a floating bar so it can be dragged to an alternate location of the computer screen.

Purchase Menu (displayed only while in trial mode) (Apple/Windows)__________________________________
Buy Online
Link to shopping cart.

Purchase Menu (displayed in a fully-activated version) (Apple/Windows)_______________________________
Transfer Activation
Transfer Serial Number off of computer.

Language Menu (Apple/Windows)_____________________________________________________________
Languages
Select 1 English, 2 Español (Spanish), or 3 Français (French).

Support Menu (Apple/Windows)_______________________________________________________________
User Guide
Quick link to User Guide Resource.

Technical Support
Quick link to softwareforscreenprinters.com SUPPORT page.

Install Software Update
Active when FREE Updates are. Option grayed out when no updates. Check periodically.
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The Quick Menu delivers 12 Menu Functions to the User Interface Tool Bar.
Black Pearl delivered twelve Menu features in a convenient Quick Menu. This enhancement brought features and controls to
the Tool Bar to streamline your workflow.

LEFT:
The Quick Menu, available in the Tool Bar, provides fast access to important features. To view
the Tool Bar launch (open) AccuRIP.

Each of the Quick Menu features above have been explained previously in the Menu and Tools section (see page 22 - 24).
Locate the Quick Menu in the upper right of the Tool Bar.
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N-UP Printing (Nesting)
N-Up printing places multiple color separations on a single sheet of film, or makes better use of roll film space, it is the
automatic version of manual nesting. VIDEO: https://www.youtube.com/watch?v=z2VWRIjUQ5w
To manually nest images other RIP stop the workflow, the user has to go into a software other than the software they just
printed from, arrange separations until they are placed on the film in positions that make better user of the film, then they
release the prints to the printer.
N-UP does all this much easier. Configure AccuRIP to match the film sheet or roll size media installed into the printer.
Now, the magic all happens based on your document width and height. Lets say you have 13x19 film loaded into the printer
and AccuRIP set for that film size, if you create a document size that is less than half of 13” (6” or smaller to allow for a 1”
postscript no print margin), lets say 6”x6”, printing a 2 color separation will result in 2 separations side by side on the same
film.

Understanding Printer Connections - though you no longer need to!
One of the greatest assests of AccuRIP Software from its first release was it seemlessly worked in the background as an ondemand driver-based solution. It was the software you used everyday, yet you didn’t have to launch or manage it. Basically you
forgot about it! Following that great tradition, the newest (greatest) assest of AccuRIP Black Pearl is you can forget all about
printer conection types, WiFi, Ethernet, IP addresses, ports, and more. How many users really have a solid understanding?
How many can troubleshoot connection issues?
AccuRIP Black Pearl has made printer connections - a no brainer. AccuRIP Black Pearl AUTO detects and connects.
So long CONNECTION CONFUSION!

Status Bar
The Status Bar is located on the bottom of the Job Queue Window (available when AccuRIP is launched). In AccuRIP Black
Pearl the Status Bar now reports Halftone settings (shape, frequency, and angle) and the configured Printer model.
This will prevent user errors that lead to film waste and wasted time.

ABOVE: Example of a Status Bar on a Windows OS. In this example, the halftone shape is ROUND, 10 LPI, and a 22.5 degree screen angle. The selected
printer model is an Epson Artisan 1430.
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AccuRIP Black Pearl User Interface
With AccuRIP setup and the AccuRIP to Epson Driver created, you are ready to produce films.
Select the AccuRIP to Epson Driver in the PRINT Window of your graphics program. AccuRIP Black Pearl quickly translates
the graphics file, sending the translated PostScript data to the Epson Inkjet printer. AccuRIP does NOT need to be launched
(open) to send a file to print. Launch AccuRIP when you wish to view the User Interface.

ABOVE: AccuRIP Black Pearl User Interface (Windows OS).
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Film Output with AccuRIP - Quick Tour.
Output success has everything to do with file building in graphics programs, print window choices, ink and film
brands, and the health of the hardware. AccuRIP has everything you need to produce professional films.
Visit www.softwareforscreenprinters.com for additional resources.
AccuRIP delivers dark, dense solids, crisp text, clean halftones, smooth gradients, blends, and all other manners of
PostScript data.

It starts with the graphic file:
Screen-printers are primarily creating files with Adobe and Corel Software. AccuRIP Black Pearl Software fits perfectly
into the pre-press world of Adobe and Corel users, and works with any PostScript graphics program. Here is how simple
it is to print with AccuRIP Black Pearl...

1. Build a proper art file.
2. Select “separations” (not composite) in the Print Window of your graphics program.
3. Select the AccuRIP to Epson Driver (not just the Epson Driver) as your “printer”.

What screen-printers making film separations need to know...
Understanding file creation, spot colors vs process colors, and a solid working knowledge of the graphics program
PRINT Window (i.e., Adobe, Corel) will save time and prevent user created output errors. AccuRIP prints the data the
way your file is set up. AccuRIP never alters data.
Use the resources provided by your graphics program manufacturers such as Adobe and Corel. Go to the Help Menus
of Adobe and Corel to fully understand and operate their software. Posted on our website are also Videos and Articles
custom developed for our users for their convenience: www.softwareforscreenprinters.com
Be mindful to SIZE the file’s artboard (the page) properly. For example, don’t float a 4” x 4” left chest design on a 13” x
19” artboard. You’ll waste film and miss out on AccuRIP’s automatic nesting feature called N-UP Printing.
Use “true” spot colors for spot color file creation. Users still misunderstand spot vs process. You’re not alone, watch our
videos on www.softwareforscreenprinters.com/videos which show Adobe Illustrator and CorelDRAW spot color creation and use. A 100% spot color delivers a solid (not a halftone) when output. When you desire a halftone (tint) then
color the spot color any percentage under 100%, or create a blend/gradient. AccuRIP can NOT alter data, but the user
can make an error. If it’s wrong on the film, the file is wrong. Review all the elements in your art file.
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CMYK
If you wish to produce a 4-color (cmyk) separation you can. AccuRIP outputs both spot and process. A process color is
made up of percentages of cyan, magenta, yellow and black.
When printing files from AccuRIP, select Separation (Corel) or Separations host-based (Adobe) and NEVER Composite
from within the Print Window. Graphic program Print Windows vary, even within versions so know your well.
Select the AccuRIP to Epson Driver as your PRINTER in the Print Window. DO NOT use the Epson Driver.
Remember: AccuRIP does it job starting at the moment the AccuRIP to Epson Driver sends the file to print and NOT
before. All PostScript translations are handled accurately by AccuRIP, so your non-Postscript Epson Inkjet prints like a
Postscript printer. PostScript is the specialized language of graphic files.

Top User Errors to Avoid:
WEB LINKS: https://softwareforscreenprinters.com/top-ten-resolves/
The number one user selection ERROR within Adobe Illustrator and CorelDRAW is selecting COMPOSITE in the General
TAB of the Print Window. This is an incorrect selection. All files are printed as Separation (Corel), or Separations Hostbased (Adobe), even when printing a single color file.
Another user ERROR is selecting just the Epson Driver as their selected PRINTER. You MUST select the AccuRIP to Epson
Driver to print with AccuRIP and achieve true PostScript file output.
Users assume the colors on screen that look solid are true spot colors. When a halftone is applied during file output, the
file absolutely contains a process (cmyk) color or a tint of a true spot color.
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Contact Information
Thank you for reading the AccuRIP User Guide!

Freehand Graphics, Inc.
4250 Veterans Memorial Highway
Suite 3040 West Wing
Holbrook, NY 11741
www.softwareforscreenprinters.com
631-744-4330 PH
Sales Office Hours: Monday through Friday, 10:00 am to 5:0 pm EST.
Technical Support is accessed via an online portal: https://softwareforscreenprinters.com/live-agent-support/
Live Agent Support is available during normal sales office business hours. Access to online articles and videos in 24/7.

Why is the version named Black Pearl?
Pearls are highly valued gemstones, and a metaphor for something rare, fine, admirable and valuable. Yet, they wouldn’t exist
without the efforts of a living organism.
AccuRIP Black Pearl is a gem of a release, delivering great value to screen-printers. Like the pearl, it wouldn’t exist without the
great efforts of our entire team. Not just any pearl, but Black Pearl, because nothing is more valuable to film production than a
dark, light blocking film created with black dye, plus the NEW User Interface has been designed with an easier on the eyes black
background.

